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Die Informationen in der vorliegenden Dokumentation enthalten allgemeine Beschreibungen und/oder 

technische Leistungsmerkmale der hier erwähnten Produkte. Diese Dokumentation dient nicht als Ersatz 

für das Ermitteln der Eignung oder Verlässlichkeit dieser Produkte für bestimmte Verwendungsbereiche 

des Benutzers und darf nicht zu diesem Zweck verwendet werden. Jeder Benutzer oder Integrator ist 

verpflichtet, angemessene und vollständige Risikoanalysen, Bewertungen und Tests der Produkte im 

Hinblick auf deren jeweils spezifischen Verwendungszweck vorzunehmen. Weder Schneider Electric 

noch deren Tochtergesellschaften oder verbundenen Unternehmen sind für einen Missbrauch der 

Informationen in der vorliegenden Dokumentation verantwortlich oder können diesbezüglich haftbar 

gemacht werden. Wenn Sie Verbesserungs- oder Ergänzungsvorschläge haben oder Fehler in dieser 

Veröffentlichung gefunden haben, benachrichtigen Sie uns bitte. 

Dieses Dokument darf ohne entsprechende vorhergehende, ausdrückliche und schriftliche 

Genehmigung durch Schneider Electric weder in Teilen noch als Ganzes in keiner Form und auf keine 

Weise, weder anhand elektronischer noch mechanischer Hilfsmittel, reproduziert oder fotokopiert 

werden.

Bei der Montage und Verwendung dieses Produkts sind alle zutreffenden staatlichen, landesspezi-

fischen, regionalen und lokalen Sicherheitsbestimmungen zu beachten. Aus Sicherheitsgründen und um 

die Übereinstimmung mit dokumentierten Systemdaten besser zu gewährleisten, sollten Reparaturen an 

Komponenten nur vom Hersteller vorgenommen werden.

Beim Einsatz von Geräten für Anwendungen mit technischen Sicherheitsanforderungen sind die 

relevanten Anweisungen zu beachten. 

Die Verwendung anderer Software als der Schneider Electric-eigenen bzw. einer von Schneider Electric 

genehmigten Software in Verbindung mit den Hardwareprodukten von Schneider Electric kann 

Körperverletzung, Schäden oder einen fehlerhaften Betrieb zur Folge haben.

Die Nichtbeachtung dieser Informationen kann Verletzungen oder Materialschaden zur Folge haben!

© 2010 Schneider Electric. Alle Rechte vorbehalten.
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Über dieses Buch
Auf einen Blick

Ziel dieses Dokuments

Diese Anleitung beschreibt anhand eines Applikationsbeispiels die verschiedenen Schritte zur schnellen 

Installation, Konfiguration und Steuerung der TeSys U -Motorstarter. Darüber hinaus können Sie mithilfe 

dieses Schnelleinstiegs auf einfache Weise ein Advantys STB-Kommunikationsnetzwerk einrichten. 

Voraussetzung hierfür sind jedoch Grundkenntnisse über speicherprogrammierbare Steuerungen (SPS) 

und applikationsspezifische Software (Advantys, Unity Pro). Sie benötigen keine weiteren Unterlagen, 

um diese Aufgabe durchzuführen. 

Weitere Einzelheiten über andere Leistungen der TeSys U-Motorstarter finden Sie in den unten 

aufgeführten Dokumenten.

Gültigkeitsbereich

Die in diesem Schnelleinstieg enthaltenen Informationen gelten für die in dem Applikationsbeispiel 

verwendete Hardware und Software. Dieselben Verfahren können mit anderen Versionen der Hardware 

und Software angewendet werden, sofern die verwendeten Versionen kompatibel sind.

Weiterführende Dokumentation

Diese technischen Veröffentlichungen sowie andere technische Informationen stehen auf unserer 

Website www.schneider-electric.com zum Download bereit.

Benutzerkommentar

Ihre Anmerkungen und Hinweise sind uns jederzeit willkommen. Senden Sie sie einfach an unsere 

E-mail-Adresse: techcomm@schneider-electric.com.

Titel der Dokumentation Referenz-Nummer

TeSys U LULC15 Advantys STB Kommunikationsmodul - Benutzerhandbuch 1744083

TeSys U-Kommunikationsvariablen - Benutzerhandbuch 1744082

TeSys U-Starter LUB/LUS - Kurzanleitung 1629984

TeSys DFB-Angebot V2 für Unity Pro - Benutzerhandbuch 1672609

Advantys STB Standard CANopen Netzwerk-Schnittstellenmodul - Applikationsleitfaden 31003684
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Einführung 
Inhalt dieses Kapitels

Dieses Kapitel enthält die folgenden Themen:

Beschreibung der Applikation

Einführung

Das Applikationsbeispiel hilft Ihnen bei der schrittweisen Definition der D.O.L.-Motorstarter (Direktstarter) 

zwecks: 

 Bereitstellung des thermomagnetischen Schutzes,

 Motorregelung und

 Erzielung der Rückführung des Schützes und der Schutzschalterauslösung.

Beschreibung der Applikation

 Motor 1 (M1):

Drehstrommotor Klasse 10, 5,5 kW (7.5 hp) bei 440 V, 50 Hz, Nennstrom In = 10,5 A, D.O.L. 

 Motor 2 (M2):

Drehstrommotor Klasse 20, 7,5 kW (10 hp) bei 440 V, 50 Hz, Nennstrom In = 14,7 A, D.O.L. mit 

Fernüberwachung der Motorlast.

Konventionelle Lösung

Das untenstehende Schema zeigt die Verdrahtung bei Verwendung der konventionellen Lösung: alle 

Informationen zur Regelung und Rückführung werden über eine SPS geschaltet.

Thema Seite

Beschreibung der Applikation 5

Motorstarter Tesys U - die Lösung aus dem Hause Schneider Electric 6

Schema für Leistung Schema für Steuerung
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Einführung
Motorstarter Tesys U - die Lösung aus dem Hause Schneider Electric 

Schaltpläne für Leistung und Steuerung in der von Schneider Electric angebotenen Lösung 

In der Lösung von Schneider Electric verwendete Steuereinheiten

Die hier beschriebene Lösung von Schneider Electric verwendet TeSys U, um den verschiedenen 

Kundenanforderungen gerecht zu werden.

 LUCA12BL ist eine mit Motor 1 verwendete Standard-Steuereinheit zur Erfüllung der 

Grundbedürfnisse:

 Dezentrale Motorsteuerung (Start/Stopp)

 Bereitstellung von Statusinformationen (bereit, in Betrieb, Fehlerbedingung)

 LUCD18BL ist eine erweiterte Steuereinheit, die mit Motor 2 über die Standardbedürfnisse hinaus für 

zusätzliche Anforderungen verwendet wird:

 Warnmeldungen

 automatisches und dezentrales Rücksetzen über den Bus

 Angabe der Motorlast

 differenzierte Fehlererkennung

Schema für Leistung Schema für Steuerung

1. Modicon M340 BMXP342010-Prozessor mit 

integriertem CANopen Master-Bus

2. TSXCANKCDF90T Steckverbinder

3. STBNCO2212 Advantys STB Standard-Netzwerk-

Schnittstellenmodul zum Anschluss an CANopen

4. Vorverdrahtete Spulenverbindung LU9BN11L

5. LU9RCD10 Bus-Anschlusskabel zum ersten TeSys U

6. LU9RDD10 Bus-Anschlusskabel zwischen den 

Advantys STB-Modulen

7. LU9RFL15 TeSys U-Leitungsabschluss

A
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A
2

LUCAppBL
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Einführung
Architektur des TeSys U-Systems

Die folgende Architektur zeigt die Hauptkomponenten eines auf Grundplatte montierten TeSys U-

Systems:

Legende Bestellnummer Beschreibung

1 Modicon M340 Speicherprogrammierbare Steuerung (SPS)

STB-Insel aus folgenden Komponenten:

2 TSXCANKCDF90T CANopen 90°  SUB-D9-Steckverbinder in Position ON

3 STBNCO2212 Netzwerk-Schnittstellenmodul (NIM) mit CANopen-Bus

4 STBPDT3100 STB Spannungsverteilungsmodul (PDM) für 24 V

5 STBDDO3200 Digitales Ausgangsmodul

6 STBXBE1100 „End of Segment“ (EOS)-Erweiterungsmodul

7 LU9RCD10 Bus-Anschlusskabel, 90° /gerade, mit einem Steckverbinder für Insel-Bus-

Verlängerungskabel an jedem Ende, zur Übertragung von Bus-Signalen und 

der internen Spannungsversorgung; ermöglicht den Anschluss des ersten 

TeSys U-Kommunikationsmoduls (maximal 1 m (39.4 in.), je nach Größe des 

Netzwerks zurechtzuschneiden)

8 LUB12 Grundgerät (Leistungsbasis) TeSys U 

9 LUCA12BL Standard-Steuereinheit

10, 13 LULC15 Advantys STB-Kommunikationsmodul

11 LUB32 Grundgerät (Leistungsbasis) TeSys U

12 LUCD18BL Steuereinheit „Erweitert“ 

14 LU9RFL15 TeSys U Leitungsabschluss-Adapter

15 LU9RDD10 Bus-Anschlusskabel, gerade/gerade, mit einem Steckverbinder für Insel-

Bus-Verlängerungskabel an jedem Ende, zur Übertragung von Bus-Signalen 

und der internen Spannungsversorgung; ermöglicht den Anschluss zwischen 

LULC15-Kommunikationsmodulen (maximal 1 m (39.4 in.), je nach Größe 

des Netzwerks zurechtzuschneiden)

16 LU9BN11L Vorverdrahtete Spulenverbindung (optional) oder

17 Standardanschluss im 

Lieferumfang des 

LULC15 enthalten

Steckbare Klemmenleiste für direkte Steuerung von A1/A2-Klemmen

1 2 3 5 64 7 8 9 10

14

15

11

12

13

16 / 17
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Einführung
Software-Tools

Die folgenden Software-Tools müssen zum Einstellen der Applikationen verwendet werden. Für die 

Verwendung dieser Tools sind Basiskenntnisse erforderlich.

Feldbus-Netzwerk

Protokoll: CANopen

Baudrate: 500 kbps

Konfiguration des Fehlerausweichmodus für TeSys U im STB Sub-Netzwerk

Im Falle eines Kommunikationsverlustes mit der SPS, bietet der Fehlerausweichmodus die Möglichkeit, 

den Motor auf verschiedene Arten zu betreiben. Stellen Sie den Parameter 682 auf einen der folgenden 

Werte ein:

Der an die Applikation angepasste Fehlerausweichmodus ist:

 Wert 1 = Eingefroren für Motor 1

 Wert 2 = Forcierter Halt für Motor 2

Bestellnummer Freeware Beschreibung

STB SPU 1000 — Advantys V2.5 Konfigurationssoftware für das 

dezentrale Advantys STB E/A-System.

UNY SPU EFM CD40 — Unity Pro Extra Large V4.0 Programmiersoftware 

für SPS M340.

— Datei 

STBNCO2212_0301E.eds
Von der Unity Pro XL Konfigurationssoftware 

verwendete elektronische Datenblatt-Datei (EDS) 

zur ordnungsgemäßen Steuerung der Geräte. 

Laden Sie die .eds-Datei von der Webseite 

www.schneider-electric.com herunter.

— DFB-Bibliothek, einschließlich 

Ctrl_cmd_u

Zyklische TeSys U-Regelung/Steuerung. Laden Sie 

die TeSys U DFB-Bibliothek von der Webseite 

www.schneider-electric.com herunter.

Wert Fehlerausweichmodus Beschreibung

0 Deaktiviert Es wird kein Ausweichmodus angewandt. Dies ist nicht empfehlenswert.

1 Eingefroren Bei Erkennen eines Kommunikationsverlustes behält der Motor seinen Status:

 Läuft der Motor, bleibt er in diesem Zustand.

 Stoppt der Motor, bleibt er im Stoppzustand.

Es ist kein Wechsel des Steuerungsstatus zulässig. Eine neuer Befehl wird erst 

nach dem Rücksetzen eines Kommunikationsverlustes berücksichtigt (703.3).

2 Forcierter Halt 

(Standardwert)

Der Motor wird in den Stopp-Zustand forciert.

Ausgang OA1 = 0

Ausgang OA3 = 0

3 Unverändert Ein Wechsel des Steuerungsstatus ist zulässig. Eine neuer Befehl wird sogar vor 

dem Rücksetzen eines Kommunikationsverlustes berücksichtigt (703.3).

4 Forcierter Rechtslauf Ausgang OA1 = 1 (direkt) 

Ausgang OA3 = 0

5 Forcierter Linkslauf Ausgang OA1 = 0

Ausgang OA3 = 1 (2 Drehrichtungen)
8 1672608 01/2010
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Einrichten der Motorabgänge TeSys U
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Einrichten der Motorabgänge TeSys U 
Inhalt dieses Kapitels

Dieses Kapitel enthält die folgenden Themen:

Einstellungen für LUCA12BL und LUCD18BL

Einstellen des Strombereichs an den Steuereinheiten

Die nachfolgende Abbildung zeigt, wie der Strombereich der Steuereinheit mit einem Schraubendreher 

(in diesem Fall LUCA12BL) eingestellt wird:

Stromeinstellungswerte

Die nachfolgende Tabelle zeigt die Einstellungen für LUCA12BL (Steuereinheit „Standard“) und für 

LUCD18BL (Steuereinheit „Erweitert“):

Thema Seite

Einstellungen für LUCA12BL und LUCD18BL 9

LULC15 Steckverbinder, Baudrate und Adresseinstellungen 10

4.00A

LULC15

5.00A

7.00A

9.00A

12.0A

3.00A

LUCA / LUCD
TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Steuereinheit Motor Stromeinstellbereich Motor-Nennleistung Stromeinstellwert = 

Motor-Bemessungsstrom

LUCA12BL M1 3...12 A 5,5 kW (7.5 hp) 10,5 A

LUCD18BL M2 4,4...18 A 7,5 kW (10 hp) 14,7 A
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Einrichten der Motorabgänge TeSys U
LULC15 Steckverbinder, Baudrate und Adresseinstellungen

Beschreibung

Die Steckverbinder unter dem LULC15-Kommunikationsmodul sind wie folgt belegt:

1 E/A-Klemmenleisten und 24 VDC

2 Bus OUT (Logikausgang 1)

3 Bus IN (Logikeingänge 1 und 2)

4 Ausgänge COM, OA1, OA3

Baudrate und Adresseinstellungen

Die Kommunikationsparameter einschließlich der Einstellungen für Adresse und Baudrate des LULC15-

Kommunikationsmoduls werden automatisch definiert.

4

3

2

1
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Einrichten eines Kommunikationsnetzwerks in einer SPS
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Einrichten eines Kommunikationsnetzwerks in 

einer SPS
Einführung

Dieses Kapitel beschreibt die schrittweise Einrichtung eines Kommunikationsnetzes in einer SPS.

Zur Einrichtung der Kommunikation mit einer SPS des Typs Modicon M340 sind die 2 folgenden 

Software-Tools erforderlich:

 Advantys

 Unity Pro

Inhalt dieses Kapitels

Dieses Kapitel enthält die folgenden Themen:

Thema Seite

3.1 TeSys U in einem Advantys STB-Netzwerk mit Advantys und Unity Pro konfigurieren 12

3.2. DFB-Konfiguration über die Applikation 17
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Einrichten eines Kommunikationsnetzwerks in einer SPS
3.1 TeSys U in einem Advantys STB-Netzwerk mit Advantys und Unity Pro konfigurieren

Konfigurationsverfahren

1)  Herunterladen und Installieren der EDS-Dateien

Die relevanten EDS-Dateien müssen in Unity vorhanden sein. Die folgende Tabelle beschreibt die zu 

befolgenden Schritte, gemäß denen die Tesys U zugeordneten EDS-Dateien und Symboldateien bei 

Bedarf von der Webseite www.schneider-electric.com heruntergeladen werden können:

Schritt Aktion

1 Rufen Sie die Webseite von Schneider Electric auf: www.schneider-electric.com.

2 Geben Sie Advantys STB in das Suchfeld ein.

3 Klicken Sie im Bereich Product Ranges auf Advantys STB.

4 Klicken Sie auf die Registerkarte Downloads und anschließend auf Software/Firmware.

5 Wählen Sie STBNCO2212 CANopen .eds and .dib Files 2/8/06 und laden Sie die Datei 

stbnco2212_canopen_eds_1_2006.zip herunter.

6 Extrahieren Sie die Datei stbnco2212_canopen_eds_1_2006.zip auf Ihre Festplatte. Sie enthält die 

Datei STBNCO2212_0301E.eds.

7

Wählen Sie von der Schaltfläche  Start aus das Menü Alle Programme und browsen Sie zum 

Menüpunkt Schneider Electric → Unity Pro → Hardware Catalog Manager.

8 Wählen Sie im Fenster Hardware Catalog Manager die Option Edit → Add.

9 Browsen Sie in dem sich öffnenden Fenster zu der Datei STBNCO2212_0301E.eds und klicken Sie 

diese an.

10 Bestätigen Sie durch Anklicken von Open.

11 Prüfen Sie im Fenster Device Profile, ob im Feld Family die Option Distributed I/Os gewählt ist, und 

bestätigen Sie durch Anklicken von OK.

Resultat: Das Gerät erscheint im Fenster Hardware Catalog Manager.

12 Klicken Sie im Fenster Hardware Catalog Manager auf die Schaltfläche Build Catalog und 

anschließend auf Close.
12 1672608 01/2010



Einrichten eines Kommunikationsnetzwerks in einer SPS
2)  Konfigurieren der STB-Insel mit Advantys-Software

Nachfolgend wird der Teil des Konfigurationsverfahrens mit Advantys-Software beschrieben:

Schritt Aktion

1 Starten Sie die Software Advantys V2.5.

2 Klicken Sie auf das STB-Symbol und wählen Sie eine Sprache.

3 Legen Sie über das Menü File einen neuen Arbeitsbereich an, in dem auch eine Insel-Datei enthalten ist.

4 Prüfen Sie, ob die Insel entriegelt ist: Das Schlüsselsymbol in der Symbolleiste darf nicht aktiviert sein.

5 Konfigurieren Sie die STB-Insel über die verfügbaren Module im Ordner STB - Catalog im Catalog 

Browser.

Wählen und doppelklicken Sie nacheinander auf die folgenden Module:

 Networking → STBNCO2212 - V3.xx für das Netzwerk-Schnittstellenmodul (NIM) 

 Power → STBPDT3100 - V1.xx für das Spannungsverteilungsmodul (PDM)

 Digital Output → STBDDO3200 - V1.xx für das Advantys E/A-Modul

 Accessories → STBXBE1100 - V1.xx für das EOS, vorausgesetzt, bei dem letzten Modul am Insel-

Bus handelt es sich um ein TeSys U-Gerät.

Resultat: Die gewählten Module werden im Insel-Editor angezeigt.

HINWEIS: Wenn die Module Ihrer Applikation nicht im Hardware-Katalog verfügbar sind, aktualisieren 

Sie den Katalog wie folgt:

 Rufen Sie die Webseite Schneider Electric auf: www.schneider-electric.com.

 Geben Sie Advantys Database Update in das Suchfeld ein.

 Klicken Sie im Bereich Software auf Advantys Database Update V 2.53 for Configuration 

Software.

 Laden Sie die Datei advantys_csw_2501_database_update_253_english.exe herunter.

 Doppelklicken Sie auf advantys_csw_2501_database_update_253_english.exe.

 Führen Sie zur Installation der Datei die folgenden Schritte aus.

 Wählen Sie in der Advantys-Software den Menübefehl Options → Settings.

 Richten Sie unter Path settings den Pfad von EDS files import ein, indem Sie auf Ihrer Festplatte 

zu dem Ordner browsen, indem Sie die .exe-Datei installiert haben.

 Klicken Sie auf OK, um das Dialogsfenster Settings zu schließen.

6 Fügen Sie die 2 TeSys U-Systeme in der angegebenen Reihenfolge hinzu, indem Sie sie jeweils 

markieren und auf das Label doppelklicken:

 Preferred → TeSys U Sc St - V1.xx für das Standard- TeSys U

 Preferred → TeSys U Sc Ad - V1.xx für das erweiterte TeSys U

HINWEIS: 

 Sc steht für Starter-Controller (Motorabgang).

 St und Ad stehen für Standard- und Advanced (erweiterte) Steuereinheit.

7 Fügen Sie das Abschlussgerät hinzu, indem Sie Accessories → TeSys U LU9RFL15 - V1.xx wählen 

und auf den Namen des Leitungsabschlussadapters doppelklicken.
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Einrichten eines Kommunikationsnetzwerks in einer SPS
3)  Konfigurieren des Applikationsnetzwerks mit Unity Pro XL-Software

Setzen Sie die Konfiguration mit der Unity Pro XL-Software fort, wie weiter unten beschrieben:

8 Doppelklicken Sie der Reihe nach auf die TeSys U-Bilder. Konfigurieren Sie in dem sich öffnenden 

Dialogfenster den Fehlerausweichmodus für Kommunikationsverlust: Klappen Sie die Liste Setting in 

der Registerkarte Parameters auf und wählen Sie Fallback Strategy (682). Unter Configured Value:

 Setzen Sie für TeSys U Sc St den Fehlerausweichmodus für Kommunikationsverlust in der 

Dropdown-Liste auf Frozen und bestätigen Sie durch Anklicken von OK.

 Stellen Sie für TeSys U Sc Ad den Fehlerausweichmodus bei Kommunikationsverlust ein: Forced Stop.

9 Speichern Sie die Applikation und klicken Sie auf das Build-Symbol.

Resultat: Das Protokollfenster müsste folgende Meldung anzeigen: „Build completed successfully“.

10 Wählen Sie File → Export [project name] und exportieren Sie Ihr Projekt als .dcf-Datei.

11 Speichern Sie die Applikation erneut und beenden Sie die Advantys-Software.

Schritt Aktion

Schritt Aktion

1 Starten Sie die Software Unity Pro XL V4.0.

2 Konfigurieren Sie den Prozessor der Modicon M340 SPS:

 Erstellen Sie über das Menü File ein neues Projekt.

 Wählen Sie im Fenster New Project das Modul Modicon M340 aus der Liste BMX P34 2010 

(CPU 340-20 Modbus CANopen).

 Bestätigen Sie durch Anklicken von OK.

3 Wählen Sie im Menü Structural view (Strukturansicht) des Project Browser (Projekt-Browser) die 

Option Configuration → 3 : CANopen. 

4 Doppelklicken Sie in der Registerkarte CANopen auf das Gerät:

Ein Dialogfenster New Device öffnet sich.

5 Legen Sie im Fenster New Device die Konfiguration des ersten CANopen Netzwerk-Schnittstellenmoduls 

(NIM) wie folgt fest:

 Wählen Sie CANopen drop → Distributed I/Os → STB_NCO_2212.

HINWEIS: Wenn das Netzwerk-Schnittstellenmodul der Applikation nicht in der Liste „Distributed I/O“ 

erscheint, müssen Sie die relevanten .eds-Dateien herunterladen und installieren (siehe Seite 12).

 Setzen Sie die Option Topological Address auf 4.

 Bestätigen Sie durch Anklicken von OK.
14 1672608 01/2010



Einrichten eines Kommunikationsnetzwerks in einer SPS
6 Wählen Sie im Menü Structural view (Strukturansicht) im Project Browser (Projekt-Browser) die 

Menüoption Configuration → 3 : CANopen → 4 : CANopen drop → 0.0 : STB_NCO_2212 und 

doppelklicken Sie auf den Namen des Netzwerk-Schnittstellenmoduls (NIM). Daraufhin öffnet sich der 

STB_NCO_2212-Bildschirm in einer neuen Registerkarte.

7 Maskieren Sie in der Registerkarte PDO die leeren PDOs, klicken Sie auf die Schaltfläche Import DCF... 

und browsen Sie zu der .dcf-Datei, die Sie beim Konfigurieren der Applikation in Advantys exportiert 

haben.

Resultat: Die PDOs erscheinen daraufhin mit den zugehörigen topologischen Adressen auf dem 

Bildschirm.

HINWEIS: In den Benutzerhandbüchern TeSys U LULC15 Advantys STB-Kommunikationsmodul und 

TeSys U Kommunikationsvariablen finden Sie Details zur Benennung der topologischen Adressen in der 

Weise, dass eine Programmierung mit Namen vermieden wird, die keine Informationen über den Inhalt 

des Speicherorts enthalten.

Beispiel: In der Applikation werden folgende Symbole für die Programmierung des DFB von Motor 1 

(Standard-TeSys U) verwendet:

 Abbildung der Eingangsdaten:

 PDO4: Symbol reg_455_M1 anstelle von %IW\3.4\0.0.0.96

 Abbildung der Ausgangsdaten:

 PDO3: Symbol reg_704_M1 anstelle von %QW\3.4\0.0.0.96

 PDO3: Symbol reg_703_M1 anstelle von %QW\3.4\0.0.0.97

8 Wählen Sie im Menü Structural view (Strukturansicht) des Project Browser (Projekt-Browsers) die 

Option Configuration → 0 : PLC bus → 0 : BMX XBP 0800 → 0 : BMX P34 2010 → CANopen. Daraufhin 

öffnet sich der CANopen communicator head-Bildschirm in einer neuen Registerkarte.

9 Wählen Sie Build → Rebuild All Project.

HINWEIS: Im Bereich Rebuild All Project wird eine Meldung bezüglich der Anzahl der reservierten Bits 

und Wörter für IN/OUT angezeigt. Kehren Sie zum Bildschirm CANopen communicator head zurück 

und geben Sie die Werte wie angegeben in die Meldung ein.

Konfigurieren Sie die Optionen gemäß dem Applikationsbeispiel:

 Stellen Sie die Übertragungsgeschwindigkeit auf 500 kBaud ein.

 Nb. of words (%MW) muss auf 278 für Eingänge und auf 244 für Ausgänge gesetzt sein.

 Index of 1st%MW muss auf 0 für Eingänge und auf 278 für Ausgänge gesetzt sein.

 Nb. of bits (%M) muss auf 0 für Ein- und Ausgänge gesetzt sein.

10 Wählen Sie die Menüfolge Edit → Validate, um die Konfiguration zu bestätigen.

11 Wählen Sie die Menüfolge Build → Rebuild All Aroject, um das Projekt neu zu erstellen. Wenn die 

Werte korrekt sind, ändert sich der Status NOT BUILT in BUILT.

12 Speichern Sie die Applikation mit einem spezifischen Namen und beenden Sie die Unity-Software.

Schritt Aktion
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4)  Einstellen von Baudrate und Knotenadresse der Advantys STB-Insel 

Die Drehschalter am STBNCO2212 CANopen-NIM dienen zur Einstellung von Knotenadresse und 

Baudrate der Advantys STB-Insel.

Die 2 Drehschalter befinden sich an der Vorderseite des CANopen-NIM unter dem Anschluss-Port für 

den Feldbus. Jeder Drehschalter verfügt über 16 Positionen.

Gehen Sie wie folgt vor, um die Baudrate und anschließend die Knotenadresse der Advantys STB-Insel 

einzustellen: 

5)  Funktionstests des Kommunikationsnetzes einschließlich M340-SPS und -Produkte ausführen 

Schritt Aktion

1 Setzen Sie die Baudrate der Advantys STB-Insel auf 500 kBaud, indem Sie die Drehschalter am 

STBNCO2212 CANopen-NIM nacheinander auf folgende Positionen einstellen:

 Stellen Sie den unteren Schalter (BAUD RATE) auf eine beliebige unmarkierte Position ein.

 Stellen Sie den oberen Schalter (TENS) auf die gewählte Baudrate ein: 5

2 Schalten Sie die Spannungsversorgung zur Insel ein, damit das NIM die Baud-Einstellungen lesen kann.

3 Schalten Sie die Spannungsversorgung zur Insel aus.

4 Setzen Sie die Knotenadresse der Advantys STB-Insel auf 4, indem Sie die Drehschalter am 

STBNCO2212 CANopen-NIM auf folgende Positionen einstellen:

 Stellen Sie den unteren Schalter (ONES) auf 4 ein.

 Stellen Sie den oberen Schalter (TENS) auf 0 ein.

5 Schalten Sie die Spannungsversorgung zur Insel ein, damit das NIM die Adresseinstellungen lesen 

kann.

Schritt Aktion

1 Schließen Sie ein Kabel zwischen CANopen-Insel und M340-SPS an.

2 Schließen Sie über den USB-Port an Ihrem PC ein Kabel (z. B. TSXPCX3030) an die SPS M340 an.

3 Schalten Sie die SPS M340 ein.

4 Klicken Sie in der Unity Pro XL-Software auf Connect.

5 Klicken Sie auf das Menü PLC. Das Fenster Transfer Project to PLC wird geöffnet. Klicken Sie auf die 

Schaltfläche Transfer.

6 Schalten Sie die beiden TeSys U-Systeme ein: Die grüne COM-LED an der Frontseite des LULC15 blinkt 

und leuchtet dann konstant. Die Kommunikation funktioniert einwandfrei.
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3.2. DFB-Konfiguration über die Applikation

Beschreibung

Das TeSys DFB-Angebot (Derived Function Blocks) für TeSys wurde mit dem Ziel entwickelt, die 

Integration von TeSys U-Motorabgängen in SPS-Applikationen zu vereinfachen und zu optimieren.

Der DFB Ctrl_cmd_u ist zur Regelung und Steuerung eines einzelnen TeSys U-Motorabgangs (bis 

32 A/15 kW oder 20 hp) durch den zyklischen Datenaustausch in einem CANopen-Netzwerk bestimmt.

Nachfolgend sind die Schritte zur Konfiguration von DFBs aufgeführt:

1. Herunterladen der DFB-Dateien

2. Installation der DFBs in Unity Pro

3. Abruf Ihres Projekts und der DFB-Applikation in Unity Pro

Weitere Informationen finden Sie unter TeSys DFB-Angebot V2 für Unity Pro - Benutzerhandbuch.

1) Herunterladen der DFB-Dateien

Die folgende Tabelle beschreibt die zu befolgenden Schritte für den Download des TeSys DFB-Angebots 

von der Webseite www.schneider-electric.com:

2) Installation der DFBs in Unity Pro

Schritt Aktion

1 Öffnen Sie die Webseite von Schneider Electric: www.schneider-electric.com

2 Geben Sie TeSys U in das Suchfeld ein.

3 Klicken Sie im Bereich Product Ranges auf TeSys U.

4 Klicken Sie auf die Registerkarte Downloads und anschließend auf Software/Firmware.

5 Wählen Sie TeSys DFB Library for UnityPro und laden Sie die .zip-Datei auf Ihre Festplatte herunter.

Schritt Aktion

1 Extrahieren Sie den Inhalt der Datei tesys library for unitypro-1.0.2.zip auf Ihre Festplatte und 

doppelklicken Sie anschließend auf die Datei Setup.exe.

2 Wählen Sie eine Sprache für die Installation.

3 Klicken Sie im Installationsassistenten für die TeSys Bibliothek 5 Mal auf Weiter.

4 Akzeptieren Sie die Lizenzvereinbarungen und klicken Sie auf Weiter.

5 Geben Sie Ihre Kundendaten ein und klicken Sie zwei Mal auf Weiter.

6 Wählen Sie eine oder mehrere Sprachen für die Applikation, einschließlich einer Standardsprache, und 

klicken Sie auf Weiter.

7 Klicken Sie auf Installieren, um mit der Installation zu beginnen.

8 Klicken Sie in dem sich öffnenden Fenster auf die Version der Unity Pro Bibliothek und die zu 

installierende Produktfamilie.

9 Daraufhin wird ein Dialogfenster mit der folgenden Meldung eingeblendet: „The Installation Wizard has 

successfully installed TeSys Library“ (Der Installationsassistent hat die TeSys Bibliothek erfolgreich 

installiert). Beenden Sie den Installationsassistenten.
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3) Abruf Ihres Projekts und der DFB-Applikation in Unity Pro

Kenndaten der Eingänge

Die folgende Tabelle beschreibt die DFB-Eingänge und ihre Verfügbarkeit in Abhängigkeit der Steuereinheit:

Schritt Aktion

1 Starten Sie die Software Unity Pro.

2 Rufen Sie über das Menü Tools das Untermenü Type Library Manager auf. Klicken Sie auf die 

Schaltfläche Access Assistant . Wählen Sie den Ordner Ctrl_cmd_u und verschieben Sie dieses 

Element in den rechten Bereich mit dem Titel Objects to get:

Klicken Sie auf Copy into project.

3 Rechtsklicken Sie im Abschnittsfenster und wählen Sie FFB Input Assistant.... Ein leeres Function 

Input Assistant-Dialogfenster erscheint.

4 Wählen Sie das folgende Symbol neben dem Feld FFB type:

5 Browsen Sie im Dialogfenster Function Input Assistant: FFB Selection zum DFB Ctrl_cmd_u.

6 Wählen Sie Ctrl_cmd_u und bestätigen Sie mit OK.

7 Klicken Sie auf eine beliebige Stelle im Abschnittsfenster: Die grafische DFB-Darstellung wird angezeigt.

Eingang Typ Bereich Standardwert Beschreibung LUCA LUCD

Reg_455 INT 0...65535 0 Verknüpfung zum Register 455 der zyklischen 

Dateneingänge

√ √

Run_fwd EBOOL 0...1 0 Befehl zum Rechtslauf des Motors √ √

Run_rev EBOOL 0...1 0 Befehl zum Linkslauf des Motors √ √

Rst_flt EBOOL 0...1 0 Fehler Rücksetzen (im Falle eines internen 

Fehlers des Kommunikationsmoduls wird das 

Kommunikationsmodul durch einen Reset-Fehler 

auf die Werkseinstellung zurückgesetzt)

√ √

Rst_warn EBOOL 0...1 0 Warnung Rücksetzen 

(z.B. Kommunikationsverlust)

√ √

Ther_ov_test EBOOL 0...1 0 Automatischer Test bei thermischem 

Überlastfehler

  

Trip_tst EBOOL 0...1 0 Auslösungstest bei Überstrom über den 

Kommunikationsbus
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Kenndaten des Ausgangs

Die folgende Tabelle beschreibt die DFB-Ausgänge und ihre Verfügbarkeit in Abhängigkeit der 

Steuereinheit:

Programmierung DFB 1 für Motor 1

Ausgang Typ Bereich Standardwert Beschreibung LUCA LUCD

Reg_704 INT 0...65535 0 Verknüpfung zum Register 704 der zyklischen 

Datenausgänge

√ √

Reg_703 INT 0...65535 0 Verknüpfung zum Register 703 der zyklischen 

Datenausgänge

√ √

Ready EBOOL 0...1 0 System bereit: Der Drehschalter steht auf der 

Position ON (Ein) und es liegt kein Fehler vor.

√ √

Closed EBOOL 0...1 0 Polstatus: geschlossen √ √

Tripped EBOOL 0...1 0 System ausgeschaltet: Der Drehschalter steht 

auf der Position „Trip“ (Auslösung).

√ √

Fault EBOOL 0...1 0 Alle Fehler √ √

Alarm EBOOL 0...1 0 Alle Warnungen √ √

Rst_auth EBOOL 0...1 0 Fehler Rücksetzen erlaubt  √

Starting EBOOL 0...1 0 Hochlauf in Ausführung:

1 = Aufwärtsstrom ist höher als 10 % FLA

0 = Abwärtsstrom ist niedriger als 150 % FLA

 √

Running EBOOL 0...1 0 Motor läuft mit Stromerfassung, wenn höher 

als 10 % FLA

 √

Avg_curr INT 0...200 0 Mittelwert Motorstrom (% FLA)  √

Schritt Aktion

1 Benennen Sie die SPS-Register (%IW..., %QW...), die den TeSys U Registern (455, 703 und 704) 

entsprechen.

Für Knoten 1 (TeSys U_Sc_St):

 Reg_455_M1: %IW\3.4\0.0.0.96

 Reg_704_M1: %QW\3.4\0.0.0.96

 Reg_703_M1: %QW\3.4\0.0.0.97

2 Verknüpfen Sie den Eingang Run_fw DFB1 mit der Startbedingung von Motor 1.

3 Verknüpfen Sie die DFB 1-Ausgänge mit den SPS-Variablen für die Verwendung im Programm:

 Ausgang DFB 1 „Closed“ = Position von Schütz KM1

 Ausgang DFB 1 „Tripped“ = Position „Trip“ von TeSys U Q1 

4 Prüfen Sie, ob DFB 1 für Motor 1 Folgendes anzeigt:

1 Nicht zutreffend

2 Zutreffend, jedoch nicht verwendet; kann von der SPS-Applikation verwaltet werden
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Programmierung DFB 2 für Motor 2

Schritt Aktion

1 Benennen Sie die SPS-Register (%IW..., %QW...), die den TeSys U Registern (455, 703 und 704) 

entsprechen.

Für Knoten 2 (TeSys U_Sc_Ad):

 Reg_455_M2: %IW\3.4\0.0.0.98

 Reg_704_M2: %QW\3.4\0.0.0.99

 Reg_703_M2: %QW\3.4\0.0.0.100

2 Verknüpfen Sie den Eingang DFB 2 Run_fw mit der Startbedingung von Motor 2.

3 Verknüpfen Sie die DFB 2-Ausgänge mit den SPS-Variablen für die Verwendung im Programm:

 Ausgang DFB 2 „Closed“ = Position von Schütz KM2

 Ausgang DFB 2 „Tripped“ = Position „Trip“ von TeSys U Q2 

4 Verknüpfen Sie den Ausgang DFB 2 Avg_curr mit einem SPS-Register für die Verwendung des 

Strommittelwertes von Motor 2 im Programm.

5 Prüfen Sie, ob DFB 2 für Motor 2 Folgendes anzeigt:

1 Nicht zutreffend

2 Zutreffend, jedoch nicht verwendet; kann von der SPS-Applikation verwaltet werden.
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